D-Star Hotspot
einrichten unter Windows
(Soundkartenlosung)!

DG6RCH
02.04.2012



Was wird hierzu bendtigt?

1x PC mit WinXP (darf gerne ein alterer sein) mit Soundkarte und
serieller Schnittstelle (oder USB-Seriell Adapter)

1x Funkgerat (9k6 fahig, wird zum Senden und zum Empfangen genutzt)
1x Antenne
1x PTT-Interface (einfach selbst herstellbar, siehe in der Yahoo Gruppe unter Files.

1x Software (Yahoo Gruppe: pcrepeatercontroller).



Hier der Schaltplan der PTT-Steuerung!
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Zur Kontrolle ob man mit dem Reflector verbunden ist,
kann man zusatzlich eine Leuchtdiode einbauen!

(Von Pin 7 des Seriellen-Ports lber einen 4700hm Widerstand gegen Masse schalten!)



Hier eine PTT-Steuerung im RS232-Stecker!

Achtung bei Verwendung eines USB zu Serielladapters!
Nach Erfahrung funktioniert nicht jeder Adapter!

Am besten funktionieren die USB zu Serielladapter der Fa. Digitus!
Bei mir kam es bei diesem Hersteller noch zu keine Probleme.
Sei es beim Programieren von Geraten noch zum Steuern von anderen Sachen.

Es gibt aber auch billigere die auch Funktionieren (zumindest zum PTT-Steuern!).
Diese Entscheidung Uberlasse ich jedem selbst!



Anmeldung bei der Yahoo — Gruppe: pcrepeatercontroller

Alle wichtigen Infos und die Software befinden sich in der Yahoo Gruppe,
diese sind fur den erfolgreichen Aufbau des Hotspot erforderlich.

Hier stehen auch Schaltbilder und Fotos zum Download bereit.

Nach Installation der Repeater Software sind im Verzeichnis folgende Dateien.

|| en_GB.indx 26.08.2012 23:37 INDX-Datei 1KE
L | en_US.ambe 26.08.2012 23:37 AMBE-Datei 27 KB
L_| en_US.indx 26.08.2012 23:37 IMNDX-Datei 1 KB
L_| es_ES.ambe 26.08.2012 23:37 AMBE-Datei 22 KB
L_| es_ES.indx 26.08.2012 23:37 INDX-Datei 1 KB
L_| fr_FR.ambe 26.08.2012 23:37 AMEBE-Datei 20 KB
L[| fr_FR.inch 26.08.2012 23:37 INDX-Datei 1KE
=# gmsk 31.08.2012 16:48 Sicherheitskatalog 4 KB
=k | gmsk 01.09.2012 00:59 Setup-Informatio... 6 KB
== Gra SKRepeater 20.09.2012 10:32 Arnwendung 416 KB
L | it IT.ambe 26.08.2012 23:37 AMEBE-Datei 22 KB
L | ik _TT.imehe 26.08.2012 23:37 INDX-Datei 1KE
|| no_MNC.ambe 26.08.2012 23:37 AMEBE-Datei 20 KB
|| no_MNCLindx 26.08.2012 23:37 INDX-Datei 1KE
[=5] ParrotController 20.09.2012 10:33 Anwendung 155 KB
L | pl_PL.ambe 26.08.2012 23:37 AMBE-Datei 24 KB
L | pl_PL.indx 26.08.2012 23:37 IMNDX-Datei 1 KB
%] portaudio_x86.dll 06.08.2012 21:54 Anwendungserwe... 61 KB
|| se_SE.ambe 26.08.2012 23:37 AMEBE-Datei 24 KB
|| se_SE.indx 26.08.2012 23:37 INDX-Datei 1KE
SoundCardRepeater 20.09.2012 10:33 Anwendung 431 KB
%RM) 20.09.2012 10:34 Anwendung 281 KB
= TODO 20.09.2012 10:23 Textdokument 1 KB
{-»T:E Uninstall 24.09.2012 20:43 Arnwendung 419 KB
%] wxbase2Bu_vc_custom.dll 06.08.2012 22:45 Anwendungserwve... 1119 KB
%] weomsw2Bu_adv_we_custom.dll 06.08.2012 22:48 Anwendungserwve... 665 KB
%] waomsw2Bu_core_vec_custom.dll 06.08.2012 22:48 Anwendungserwve... 2697 KB
=¥ | xDVRPTR-32-64-2 12.09.2012 13:07 Setup-Informatic... 3 KB



Achtung ab Version 01.09.2012 wurde der Softwarename geéandert in Soundcard Repeater

Beim Starten der Software BStar-Repeater Soundcard Repeater erscheint folgendes Bild!

Weiter unter Edit => Preferences

Il P Sicr Repeater - 20110404

Fiiew fiction  Cutputs  Help
S

Fx State: Rpt State: Tx:
Header
LR RFT1: RFTZ:
M Flags: BER:
Timers
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Gateway
Bk, Texk:

Log




D-Star Repeater Preferences

| Callsign | Netwark | Timers | Beacon | Radio | Controller | Control 1 | Contr ¢ *

Callsign | paeRCH ](

Gateway [DGGRCH \ G

@ o

RPT1 Validation | qff v

Rufzeichenlberprifung!

Bei ON wird nur das Rufzeichen
weitergeleitet das im Callsign und Gateway
eingetragen ist!

Bei OFF kann jede Station

Uber denn Hotspot arbeiten!

Achtung!

Hier ist es wichtig welches

Modul man auswabhit!

Diese Eintragung muss Spater

auch im Gateway eingetragen werden!

[ QK Cancel ]




Einstellung Network!

D-5tar Repeater Preferences

iZallsign Timers || Radio || iZonkraller || Conkrol 1 || Conkrol 2 || Ackis & *

Gateway Address | 127.0.0.1

Gateway F'IIII"|:||:|1|:| ‘.

Local Address | 127.0.0.1

Mebwark Delay Mone A

2K | | Zancel




Einstellung der COM-Schnittstelle!

D-5tar Repeater Preferences r5_<|

Callsign || Nebtwark | Timers | Radio | Controller |C|:|r|I:r|:|I1 Contral 2 | Ackiy 4 F

Type Gerial - 'I,'I,.'I,CCID "

PTT Delay 160 ms + | | Achtung!
_ Bei Verwendung eines USB zu Seriellagapters
PTT Inversion | oy + || kann es unter Windows passieren!

Durch einstecken eines anderen USB-Plort,
andert sich die COM — Nr.!

(Lasst sich sehr leicht im Geratemanagér Gberprifen!)

I | I Zancel




Einstellen der Inversion und der Soundkarte!

Manche Gerate Invertieren das Empfangs- und Sendesignal.

Die hier richtige Einstellung muss man ausprobieren,

da es je nach Anschluss an der Soundkarte und am Geréat zu verschiedene Einstellung kommt!

Callsi i | Radio ‘Controller | Control 1 | Contr € * Soundkarte auswahlenl

| Callsign || Network | Timers _Be . .
2 Mikrofoneingang und
— = Lautsprecherausgang

Input Realtek AC97 Audio

Output

Realtek ACS7 Audio

R¥ Level (%) 0 100
Bleibt auf 100%

R gy - nicht Verstellen!
Squelch Level (%) 0 Q 1on

<_—0 —> Einstellen der internen Rauschsperre!
Sauelch o™ - Bei Squelch Mode ,Open” wird dieser

_Regler nicht bericksichtigt!

RX Inversion ‘

TX Inversion

Bei schnelleren Rechner
sollte der Squelch auf Open stehen!

Hier die Invertierung
einstellen!

[ OK ][ Cancel ]




Am besten ist die Einstellung zu finden im Anzeige Modus unter View => Gui!
Hier kann man die Aussenden uberprifen!
Sobald ein korrektes Signal Empfangen wird erscheint das Rufzeichen!

Falls nicht, muss das Empfangssignal Invertiert werden!

Ml D-Star Dcp-ater - 20120403

File Edi ction Outputs  Help
Status
R¥ State: Listening Rpt State: Listening TX: On
Receiver
Squelch: Open Moise: 25.43
Header
UR: RPT1: RPTZ:
MY Flags: BER:
Timers
Timeout: 0/180 Active: 0J0 Beacon: 0J0
Gateway
Ack Text: Verlinkt zu DCS001 R Status 1: Status 2:
Status 3: Status 4: Status 5:
Log




Bl D-Star Repeater - 20120403

File Edit WYiew Action Outputs Help

Status
RX State: Listening Rpt State: Listening TX: On
Receiver
Squelch: Open Moise: 25.43
Header
UR: RPT1: RPTZ:
MY Flags: BER:
Timers
Timeout: 0/180 Active: 0/0 Beacon: 0J0
Gateway
Ack Text: Verlinkt zu DCS001 R Status 1: Status 2:
Status 3: Status 4: Status 5:
Log

Achtung!
Der Noise-Pegel sollte bei gedffneten Squelch nicht grosser sein als 50!
Dies kann bei einigen Rechnern zu Probleme flihren!




Einstellung der Soundkarte:

diese Einstellungen variieren leider von Soundkarte zu Soundkarte,
daher kann ich hier nur zeigen wie es bei mir aussieht.

Bei anderen Soundkarten sieht der Sound-Mixer evtl. anders aus oder
hat andere Bedienelemente.

Wichtig ist nur, dass der Mikrofoneingang auch als "Aufnahmeeingang"” eingeschaltet ist.

Zunachst 6ffnet man den Mixer, geht in die Einstellungen und wahlt die Aufnahmegerate aus:

i R...[a]0/X]
Options  Help

icrophione

B alance:

B J

Select

SoundMay Digikal Audio

Hier also der Regler fiur die Aufnahme vom Mikrofon, dieser muss aktiviert werden,
man stellt ihn ungefahr in Mittelstellung oder etwas dartber.



Nun wahlt man die
Wiedergaberegler:

%1 Yolume Control

Cptions  Help
Wolurme Control W ave Microphone
BEEEE HEETIEEE SEEEEE
vt Iy S 4
Yolume: Yolume: Yolurme:
L
L
L
[ ] Mute all [ ] Mute Mute
[ Advanced
SoundMax Digital Audio

Hier ist ganz wichtig, dass man die Wiedergabe vom Mikrofon Abschaltet (Mute).
Denn sonst wirde der Ton vom Mikrofoneingang automatisch zum Lautsprecherausgang
durchgeschleift werden, was wir aber nicht brauchen kénnen.

Wave dreht man voll auf und den Lautsprecher stellt man ungefahr in Mittelstellung.



Erste Tests und Feineinstellungen:

Empfanqgsbetrieb:

Jetzt sind wir soweit um zu Prifen ob der Repeater D-Star Daten empfangen kann.

Man nimmt ein Handfunkgerét und stellt es auf DV Betrieb und die Frequenz ein,
Auf der spater der Zugang laufen soll.
Dann drickt man die PTT und beobachtet das Fenster

In der Repeatersoftware mussen jetzt im Bereich "Header" die im Funkgeréat
eingestellten Calls zu sehen sein (Mycall, Yourcall, RPT1 und RPT2).

Wenn man gar nichts sieht, so muss folgende Einstellungen geandert werden:
In den Repeatereinstellungen bei Reiter "Radio" stellt man RX Inversion um,
startet den Repeater neu und versucht es nochmals.

Achtung!
Nach einem Neustart des Repeaters bitte immer das Menu "View" neu aktivieren,
da man ansonsten gar nichts sehen kann !

Jetzt sollten die Infos vom Handfunkgerét zu sehen sein.
Notfalls kann man noch den Aufnahmepegel des Mikrofoneingangs anpassen,
aber in der Regel sollte es jetzt schon gehen.



Sendebetrieb:

Wie in D-Star Ublich, muss nattrlich das RPT1 und RPT2 des Funkgerats auf das Call des
Hotspots gestellt sein, sonst wirde der Hotspot die Aussendung ignorieren.
Mit einem zweiten Funkgerat kann man jetzt die Aussendung des Hotspots empfangen.

Wenn der Hotspot sendet, aber man kann nichts horen,
SO0 muss man in den Repeatereinstellungen im Register "Radio" TX Inversion umstellen,
startet die Repeatersoftware neu und versucht es nochmals.

Mehr wird man héren wenn spater der Internetzugang aktiviert ist.

Den Lautstarkeregler der Soundkarte stellt man so ein,
dass man ein sauberes Empfangssignal bekommt.



Einstellungen des DCSGateway

Offnen Sie das Programm DCSGateway

Hier genauso unter Edit => Preferences folgendes eintragen!

Datei  Bearbeiten  Ansicht

QZurEu:k T

Adresse [ Z) C:\Programme\Repeater

Ordner X

[ microsoft Fronkpa
|2 Microsoft Office
) MMSSTY
) Matarala
[ Mowie Maker
[ MaozBackup
[ Mozilla Firefox
=) Mozilla Sunbird
[ Mozilla Thunderbi
) MSEuild
) MSN
[ M5 Gaming Zone
) MSXML 4.0
) MSHML 6.0
) MULTIPSK
=) MetMeeting
[ OpenOffice.org 3
| ©utlook Express
[ Paxon
() PRINTKEY2000
[ Realtek AC37
| Realtek Sound Mz
[ Reference Assem
) Repeater

l.ﬁ / ) suchen

() Messenger A

[ SakScape b

Extras ¢

Marme

E.ﬁ.nalugueRepeater
[Z] cHAMGES
[Z] coryInG

de_DE.ind:x
E] DExtra_Hosks
EDExtraGateway
dk_DE. ambe
dk_DK.indx
EDStarRepeater
EDummyRepeater
Flovartiode
[FlovrPTRREpeater
en_GE,ambe
en_G6.indx
en_U5,ambe
en_U5.ind:x
es_ES.ambe
£5_ES.indx
fr_FR.ambe
fr_FR.ind=
EGMSKREpeater
it_IT.ambe
it_IT.ind:x

%] nodezz.di

[{ Crdner

E,

Gréfe
383 KE
34 KE
15 KB
1 KB
174 KE
21 KB
1KE

1 KB
171 KE
20 KE
1KE
454 KB
256 KB
306 KB
396 KB
22 KB
1KE
27 KB
1KE
22 KB
1KE
20 KE
1 KB
385 KB
22 KB
1 KB
140 KB

Typ
Arwendung
Textdokument
Textdokument
Textdokument
Arwendung
AMEBE-Datei
IMND%-Datei
Textdokument
Arwendung
AMEBE-Datei
IMND=-Datei
Anwendung
Anwendung
Anwendung
Anwendung
AMEBE-Datei
IMD=-Datei
AMEBE-Datei
IMD=-Datei
AMEBE-Datei
IMD=-Datei
AMEBE-Datei
IND=-Datkei
Anwendung
AMEBE-Datei
IND=-Datkei
Programmbibliothek:,

5 Re peater EJEJ E|

Favariten

w Wechseln zu

Geandert am ~
30032012 11:33
30.03,2012 12:35
05.01.2009 10:01
30.03,2012 09:38
00320121131
12.02,2011 14:39
12.02.2011 20026
30.03,2012 09:43
30032012 11:27
12.02,2011 14:40
13.02,2011 08:00
30.03,2012 11:30
30032012 1122
30.03.2012 11:25
30032012 1123
12.02,2011 14:41
13.02,2011 06:45
12.02,2011 14:42
16,02,2011 09:14
19.02,2011 11:19
19.02,2011 12:27
12.02,2011 14:42
12.02,2011 21:02
30.03.2012 11:26
12.02,2011 14:43
13.02,2011 07:11
27.10,2011 18:51 W




Hier das Call und die in der Repeatersoftware eingestellte Modul 8-stellig einfligen!
(Mit Leerzeichen aufflllen!)

DCS GatewayPreferences

Reflectar |Fh3|:ueater Hier wird fr zu verbindende Reflector
eingetragen!

Hier wird die Gruppe
eingetragen z.B.
C=Deutschland
R=Deutschland-Sud
V=Test Kanal

REHEE':DI“( ‘DCSDDI gv (!F!. )_4 -
Startup Vs > 3

Callsign ‘ DiEERCH ‘

ab wann sich die Software
Neu am Reflector anmeldet!
I

c

Language
9% | Deutsch b h der Regel wird hier

\uf Fixed eingestellt.

Reconngct | Fiyed v || Hier kann Eingestellt werden
|




Hier das Call und die in der Repeatersoftware eingestellte Modul 8-stellig einfligen!
(Mit Leerzeichen aufflllen!)

DCS GatewayPreferr:nces

Feflector ‘ Repeater

_ /
Zallsign (DGEERCH B

Refleckar D S001 ot =] at

Skartup Ve A

F:ecnnnec A
Languoge (Deutsch v

‘ ] 4 \ ’ Zancel




Ubersicht der Gruppen auf DCS001!

Group Modul DTMF URCALL
World Wide A D101 DCSO01AL
Europe B D102 DCS001BL
Deutschland (& D103 DCS001CL
Qesterreich D D104 DCS001DL
Nederland E D105 DCSOD1EL
ltalia F D106 DCSO01FL
Espana G D107 DCS00M1GL
United Kingdom H D108 DCS001HL
Portugal | D109 DCS001IL
Schweiz J D110 DCS001JL
Greece K D111 DCSO01KL
Australia L D112 DCS001LL
USA it} D113 DCS00TML
South America N D114 DCS001NL
Japan 0 D115 DCS0010L
Canada P D116 DCS001PL
DL-MNord Q D117 DCSO001QL
DL-Sued R D118 DCS001RL
DL-¥West S D119 DCS0015L
DL-Ost T D120 DCS001TL
Rundspruch U D121 DCSO01UL
D% Test Channel W D122 DCS001%L
APCO Test Channel WY D123 DCSO01WL
Echolink Test Channel pd D124 DCS001XL
Entwickler Treff i D125 DCSO001YL
ECHO Function z D126 DCS001ZL



Ubersicht der Gruppen auf DCS002!

Group Modul DTMF URCALL
World Wide A D201 DCS002AL
Denmark B D202 DCS002BL
Sweden C D203 DCS002CL
Finland D D204 DCS002DL
Morway E D205 DCS002EL
Belgium F D206 DCSO02FL
Poland G D207 DCS002GL
USA East H D208 DCS002HL
USA West | D209 DCS002IL
South East Europe J D210 DCS002JL
Asia K D211 DCS002KL
Russia L D212 DCS002LL
D-TERM channel M D213 DCS002ML
AGZ meeting N D214 DCS002NL
Bayern 0 D215 DCS0020L
Hamburg P D216 DCS002PL
Berlin Q D217 DCS002AL
Gransbergtreffen R D218 DCS002RL
Ham Radio Meeting b D219 DCS0025L
DL Distrikt U T D220 DCS002TL
Developers Place u D221 DCS002UL
Test Channel 1 W D222 DCS002vL
Test Channel 2 WY D223 DCS002wWL
Test Channel 3 X D224 DCS002XL
Announcements i D225 DCS002YL
ECHO Function 2 z D226 DCS002ZL



Die Firewall muss unter Windows freigeben werden!

(Lasst sich in der Systemsteuerung unter Firewall tberprifen,
Macht aber die Software bei der Installation automatisch,
wenn man die Abfrage nicht mehr Blockieren zustimmt!)

™= Windows-Firewall

&llgemein | Ausnahmen | Enweitert

Eingehende Metzwerkverbindungen mit Ausnabime der unten aufgelisteten
Frogramme und Dienste werden geblockt. Durch Hinzufugen weiterer Auznahmen
funktionieren die enteprechenden Programme eventuell beszer, aber dag
Sicherheitziziko kann sich erhohen.

Pragranirme und Dienste:

M arne

M| O atei- und Druckerfreigabe
DE stral ateway

ircDDEG atewway

] Rematedesktop

R emateunterstiitzung

O UPAP-Framewark,

[ Programm... H Part... H Bearbeiten...

Benachrichtigen, wenn Programm durch ‘windows-Firewall geblockt wird

“Wwelche Riziken bestehen beim Sulaszen von Auznahmen?

0k || abbrechen




Alle Einstellungen werden erst beim nachsten Start der Software Gbernommen!

Schliel3en Sie alle Fenster und beginnen immer mit der Repeater Software
und anschlie3end mit dem Gatway!

Jetzt sind Sie als Repeater unter Xreflector.net unter den jeweiligen DCSxxx zu sehen!

Hier eine kleine Batch-Datei zum gemeinsamen Starten

cd\

cd \Programme\Repeater

start SoundCardRepeater.exe -nolog -guli
start DCSGateway.exe -nolog —qgui

Der Zusatz —nolog Schaltet die Logfunktion ab!
Der Zusatz —gui Startet das Programm automatisch im Ansichtsmodus (View)!

Viel Spass und viel Erfolg!

DG6RCH
Christian
02.04.2012



